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Introduction
Most people will not be able to do a lot with a DDP image. For burning such an
image to CD or even for listening to it you will need a specialized software that
you will not find to be installed on most computers. HOFA DDP Player is a
simple and quite inexpensive alternative.

Installation
To install HOFA DDP Player you will need the HOFA-Plugins Manager which you
can download here:
https://hofa-plugins.de/en/download
The HOFA-Plugins Manager also allows installing all further products by HOFAPlugins which you can test for 14 days if you are interested.
Select "Install" in the field "HOFA DDP Player V2". By clicking "INSTALL" or
"APPLY CHANGES" at the bottom, the latest version of the software will be
downloaded and installed to your computer.

Activation
The license activation of the software is done using the HOFA-Plugins Manager
as well. A detailed description of the activation and deactivation process is
available here:
https://hofa-plugins.de/media/HOFA_Plugins/manuals/ActivationDeactivation_en.pdf.

Limitations of the evaluation version
If you have not yet purchased the product, you can test it for 14 days. Click on
"Start Demo" to start that 14-day period. Please use the demo period before
buying to make sure that HOFA DDP Player is compatible with your CD writer.
As a demo limitation, the right stereo channel will always be muted during
playback, and on the created CDs .

Note for Windows XP and Vista users
To burn CDs with HOFA DDP Player on Windows XP or Vista, you may need a
Microsoft update which is not installed automatically by Windows. This
"Windows Feature Pack for Storage" can be downloaded here:
https://www.microsoft.com/de-de/download/details.aspx?id=19622
Generally we do not recommend using Windows XP or Vista anymore as the
support by Microsoft has been terminated a long time ago.

Quick start
For anyone who does not like to read manuals, here is a quick start guide how
to play back a DDP image with HOFA DDP Player and write a CD from it.
– Start HOFA DDP Player
– Load a DDP image from the File menu or by dropping a DDP image folder
– Press the Play button to start playback and check if the image is OK
– Click "Burn CD"
– Select CD writer and burn the CD

Step by step
To load a DDP image (Menu: File->Load DDP image) a file dialog will open that
allows selecting folders only. A DDP image always consists of multiple files that
belong together (see chapter DDP for details). Because of that you have to
select the folder that contains all these files instead of selecting a single file
here.
A folder that contains a DDP image can also simply be dropped on the DDP
Player to load it.
While loading, the DDP image is automatically validated. An invalid image
where files are missing or that contains wrong MD5 checksums can not be
loaded.

The track list
After opening you will see the track list with all additional information
contained in the DDP image.

The track list is a table containing all CD markers for track start, pregap and
subindex. Additionally you can see the total number of tracks and the total
playing time of the CD in the bottom line.
The track list contains the following columns:
– Current position: The orange arrow on the left will show you the current
position for playback.
– Save track as audio file: With the save buttons
you can save single
tracks as audio files. Using this button in the bottom line, all tracks will
be saved.
– Track: The track number.
– Index: The type of the marker (Start, Pregap, Index 2, 3...). The
numeration of subindices will start at 2 because a CD player will display
the normal track start as subindex 1.
– CD-Time: The time position of the marker on the CD.
– Duration: The duration of a track or a pregap.
The next columns are only visible if the DDP image contains the appropriate
information. The entries will only be displayed in the lines of a track start
marker (for that track) and in the last line (for the whole CD).
– UPC/EAN: The UPC or EAN is identical in all rows, as it is always valid for
the whole CD.
– ISRC: The ISRC for this track.
– Track/Album Title: The CD-Text entry "Title" for this track or for the
whole CD.
– Track/Album Artist: The CD-Text entry "Artist" ("Performer") for this track
or for the whole CD.
– Track/Album Songwriter: The CD-Text entry "Songwriter" for this track or
for the whole CD.
– Track/Album Composer: The CD-Text entry "Composer" for this track or
for the whole CD.
– Track/Album Arranger: The CD-Text entry "Arranger" for this track or for
the whole CD.
– Track/Album Message: The CD-Text entry "Message" for this track or for
the whole CD.
– Genre: The CD-Text entry "Genre" is identical in all rows, as it is always
valid for the whole CD.
The displayed order of the columns can be adjusted by moving them with the
mouse.

By clicking on a marker line the current playback position will be set to this
marker. A double click will start playback.

The control panel
The control panel is used for controlling playback and for starting the CD
burning process.

The playback controls are just like on any CD player. The << and >> keys
have double functions. A short press will skip to the previous or next track
start. Holding them a longer time will fast forward or rewind.
The "T-Playback" button in the middle controls the track transition playback
feature. When track transition playback is enabled, the player will only play
back the transitions between tracks from 10 seconds before the end of a track
until 10 seconds after the start of the next track. This allows a quick and easy
check if all track markers and pauses are placed as intended.
Below the playback control buttons you can move the playback position inside
the current track. The end of the previous and the beginning of the next track
are also visible.
The time display shows the current playback position of the track and the
whole CD. Click on the display to toggle between current time and remaining
time.
For an objective judgement of level, loudness and stereo width HOFA DDP
Player comes with a peak meter, an EBU-mode loudness meter and a
goniometer.
The peak meter always shows a range of -60 dBFS up to 0 dBFS. The
maximum levels for left and right are shown at the right edge. The EBU-mode
loudness meter is displayed between the L/R peak meters. Loudness is only
shown as one value (and not for left/right) according to EBU-mode
specifications. Furthermore loudness range is shown as square brackets inside
the loudness meter. More about EBU-mode and loudness range in section EBU
R 128.

To the right of the meter you can find the goniometer.
The goniometer shows three curves. Peak (grey region), Peak Hold
(white line) and Energy (white line with gradient). Peak shows the
current distribution, Peak Hold is the maximum and Energy the
averaged distribution.
The display shows a logarithmic scale of 40 dB. The scale adjusts to the level
in order to show low levels as well as high levels.
The volume control at the right is only used for playback. The volume of the
DDP image or the CD will not be modified here.

Burn CD
To start burning the CD there is the following dialog window:

In the select box "CD writer" you can select the device that should be used for
burning the CD. The CD write speed is not selectable until an empty CD has
been put into that device. Click "Start" to begin the burning process. The CD
will be ejected afterwards. If you need multiple copies of the CD, just enter the
desired number. Then you just need to put a new blank CD to your writer after
a CD is ready.
If the "Start playback when finished" option is activated, playback will start
after the last CD has been written. Please note that this will play back the
project from your hard disk and not from the CD, as the CD is ejected.

File menu
The file menu allows opening DDP images. The 10 most recently opened
images and the last 10 images that were created using "HOFA CDBurn.DDP.Master" can be selected directly from the menu.
Beside the possibility to burn a DDP image to a CD, you can also export audio
files in Wav, Aiff, FLAC, Ogg-Vorbis oder MP3 format. This can be done either
as single files per track or as one long file for the whole CD. If you just want to
save single tracks you can use the save buttons
in the tracklist. Before
saving, a dialog will be opened that allows choosing which CD-Text information
should be used to create the file names. Furthermore you can select whether
the files should include the pregap of the track or the pregap of the following
track. This can be useful e. g. for a live album where the applause after a song
is the pregap of the next track.
If your DDP image was not yet delivered with an appropriate tracklist (PQSheet), you can create one here as a PDF file.
The menu entry "Export ISO file from multisession CD" is only activated if your
DDP image is a multisession image that contains a CD-ROM data part. In this
case the CD-ROM part can be saved to an ISO file that can then be mounted to
your OS as a virtual disk.

Settings menu
In the Settings menu you can find the following basic settings used by the
application:
– Audio output device: Select the device that should be used for playback.
– Language: English or German.

Help menu
From the Help menu you can switch on and off the display of tooltips and open
this manual. Furthermore you can check if an update of the software is
available.

Keyboard shortcuts
Some functions can also be controlled from the computer keyboard:
Taste

Funktion

Ctrl / Cmd* + o

Open DDP image

Ctrl / Cmd* + q

Quit application

Enter

Start playback

0 in number pad

Stop playback

Space

Start / Stop playback

1..9

Jump to start of track 1..9

Arrow left / right

Fast forward / rewind

Arrow up / down

Jump to previous / next marker in list

* Ctrl on Windows PC / Cmd on macOS

Interesting facts
Red Book Audio-CD
The CD-A is specified in the so-called red book.
A CD-A can contain max. 79 minutes and 48 seconds of audio * which can be
separated into up to 99 tracks. The minimum length of a track is 4 seconds. In
most cases there are silent pauses between the tracks. It is also possible to
have a track change without a pause. The pause between two tracks is called
pregap. It can contain absolute silence but it can also be filled with audio. A CD
player normally displays a negative time during the pregap which runs down to
zero.
Furthermore there are subindex markers which can be used to mark a certain
position inside the track. These markers are not supported by all CD players.
In most cases they can only be displayed but it is not possible to jump to a
subindex directly.
Audio data is always stored with a sample rate of 44,1 kHz with 16 bit. On the
CD they are grouped in blocks of 588 samples, so called frames. One frame is
equal to a playing time of 1/75 second.
The markers for track start, track end and subindex are always related to a
frame. So the minimum distance between two markers is 1 frame = 1/75
second.
With HOFA DDP Player it is also possible to create CDs up to 99 minutes. To
write these, special high capacity blank CDs are necessary and your CD writer
has to support this feature. Please ask your pressing plant which maximum
length they allow. Generally it can not be guaranteed that CDs with these
lengths can be played back with every CD player.

*

In fact the red book does not define a maximum playing time but a track distance with tolerances. The first CDs
had a maximum playing time of 74 minutes. Meanwhile the production tolerances could be reduced, so that longer
times became possible. Most CD pressing plants allow a playing time of up to 79:48. CDs of 90 or even 99 minutes
are beyond the restrictions of the red book standard.

DDP
DDP* (Disc Description Protocol) is a format that describes the content of a CD.
It is frequently used to transfer the content of an Audio CD e. g. from the
mastering studio to the CD pressing plant. By using a DDP image you can
avoid the use of CD-Rs and the CD writer as a possible source of errors.
Furthermore you can transfer the final CD via the internet.
The DDP image is not a single file, but a folder. All files inside this folder belong
to the DDP image and always have to be used in this combination.
A typical DDP image folder consists of the following files:
DDPID

Contains information about the format of the DDP image

DDPMS

Contains information on which files belong to this DDP image

PQDESCR**

Contains information about the tracks, UPC/EAN and ISRC

IMAGE.DAT**

Contains audio data, so this file can be pretty large, may be
split up into multiple files

CDTEXT.BIN** Optional, contains all CD-Text information
Furthermore there is often a checksum file. Using checksums you can assure
that the single files of the image have not been modified e. g. by a transfer
error.
HOFA DDP Player supports DDP-Images for CD-A in DDP 2.00 or DDP 1.xx
format.

* DDP a registered trademark of DCA Inc.
** This name ist not defined. The file can also have a different name.

ISRC
The ISRC (International Standard Recording Code) is an identifier that is
unique for a track on a CD. When the track is played on the radio, this code
can be used for managing license fees. Normally this code is available on all
commercial CDs.
The ISRC consists of two letters followed by a 10 digit number.
The single parts are:
– Country code (2 letters), e. g. DE for Germany (Deutschland)
– Registrant code (3 digits)
– Year (2 digits)
– Designation code (5 digits)
The ISRC is always provided by a registrant. It always belongs to a certain
recording of a song. If a song is re-released, e. g. on a best-of compilation, it
will keep its ISRC. For a remix you will need to get a new code.
For further information have a look at
http://www.ifpi.org/content/section_resources/isrc.html

UPC/EAN
The UPC (Universal Product Code) or the EAN (European Article Number) used
in Europe are the numbers under the bar code that you can find on the
package of any product. For automatic identification, this number can also be
stored within the CD data. This code is also provided by a registrant. It is a
number with 12 (UPC) or 13 (EAN) digits. A 12 digit UPC will be displayed as
13 digit number with a leading zero as this is mandatory for CDs and DDP
images.

CD-Text
CD-Text is an extension to the red book standard which is supported by several
CD players. When playing a CD in your computer, you should be aware that not
every software player will show CD-Text information. Often the title information
is downloaded from the internet and can differ from the information that is
stored on the CD itself. Windows Media Player* as well as Apple iTunes**
do not show any CD-Text information! But there are freely available
extensions and other players that make this possible. For example:
For Windows:
– VLC Media Player
https://www.videolan.org/vlc/
– Winamp
http://www.winamp.com/
– Extension for Windows Media Player
http://bmproductions.fixnum.org/moreprogs/wmpcdtext.htm
For macOS:
– Extension for iTunes
https://dougscripts.com/itunes/scripts/ss.php?sp=cdtexttocdinfo
– drutil
If you like it cryptic, type drutil cdtext in the terminal window. This will
list up all CD-Text information contained on the CD in plist format.
CD-Text can store the following information for the complete album and for
each track:
– Title
– Artist/Performer
– Songwriter
– Composer
– Arranger
– Additional message
You can also specify a genre for the complete album.

* Windows Media Player is a registered trademark of Microsoft Corporation in the U.S. and other countries.
** iTunes is a trademark of Apple Inc., registered in the U.S. and other countries.

Special characters in CD-Text
The CD-Text standard as defined by Sony uses the ISO 8859-1 character
encoding which includes the most common characters used in western
European languages. Unfortunately not all languages are covered completely.
Especially some characters used in eastern European languages like Polish or
Turkish are missing.
Generally you should be aware that titles stored in CD-Text will often be
displayed on CD-Players or car stereos that have only very limited displays.
Many of these devices will not show any special characters at all. So you could
think about avoiding special characters all and replace for example a German
"ä" by its equivalent "ae".
Alternatively the CD-Text standard also allows for Japanese which is stored
using the so called Shift-JIS character encoding. This encoding does not include
the European special characters, so a mixture of both is not possible. As
mentioned before, not all CD-Players that support CD-Text will be able to
display Japanese.
HOFA DDP Player will automatically recognize the encoding used in the DDP
image and can also display CD-Text in Japanese.

EBU R 128
EBU R 128 is an EBU (European Broadcasting Union) standard defining guide
values for loudness in broadcasting. The origin of this standard lies in the
increasing loudness in broadcasting and the dynamic variations resulting from
that (e. g. adds are often louder than regular program). To counteract this
loudness normalization was introduced, aside with a referenced target level.
With EBU R 128 an open standard for loudness measurement was created. Also
new units LU and LUFS (Loudness Unit / Full Scale) were introduced. One LU is
basically the same as one dB but describes a loudness measured according to
EBU R 128. While LU is a relative level LUFS is an absolute level, the
relationship being 0 LU = -23 LUFS.
To judge the program dynamic, EBU R 128 defines the loudness range (LRA).
The loudness range quantifies the variations of loudness in time, e. g. the
proportion between louder parts and quieter parts.
EBU R 128 claims a program loudness of -23 LUFS (= 0 LU). On the other hand
the loudness of most music is about -10 LUFS, ranging up to –5 LUFS. So one
might ask why an EBU meter should be used for music.
The answer is simple: While a loudness reference of -23 LUFS isn't very
suitable for music, having a standardized tool for loudness measurement
certainly is. Due to the open standard, loudness is comparable between
different measurement tools.
The loudness range can help judging the loudness across several music titles
(premastering) or on long tracks. Especially on premastered music this value
might not be very meaningful.

Contact
HOFA GmbH
Lusshardtstraße 1-3
D-76689 Karlsdorf
E-Mail: plugins@hofa.de
Telefon : 0049 7251 3472 444
hofa-plugins.de/en/

DDP® is a registered trademark of Doug Carson & Associates, Inc. (DCA, Inc and protected by
U.S. Copyright, 2004.) Disc Description Protocol and the DDP Logo are trademarks of DCA,
Inc. Copyright© DCA, Inc. 2004. All Rights Reserved.
iTunes is a trademark of Apple Inc., registered in the U.S. and other countries.
Windows Media Player is a registered trademark of Microsoft Corporation in the U.S. and other
countries.

